Case Notebook 4.5 – Release information for February 2017
The Westlaw Case Notebook release includes the following enhancements:
Batch Import Key Facts via .csv file
Quickly populate the Key Facts table with key descriptions, dates and create links to
source information using a .csv file batch import option. Sources referenced in the .csv
file will be automatically linked to existing documents in Case Notebook. Property
names in the load file will be automatically mapped by title to matching Case Notebook
Key Fact field names, or may be manually mapped by the user.
Full-text Documents, Transcripts, Pleadings and Research as Sources for Key Facts
Assign full-text Documents, Transcripts, Pleadings and Research data items as Sources
for Key Facts in Case Notebook. Data items may be associated with Key Facts in the Key
Facts Properties dialog or in the properties dialog for any particular document. Users
may search for documents by title or date on the Key Facts Properties > Sources tab.
Improved Integration with Case Timeline
Full-text source Documents, Transcripts, Pleadings and Research data items may be
exported with Key Facts from Case Notebook to Case Timeline. Custom properties
created within Case Notebook may now be exported to Case Timeline, mapped to
columns in the Timeline Event Entry Table and Chronology and displayed on charts.
Batch Import Data with Load File Improvements
Property names in the load file will automatically be mapped by title to matching Case
Notebook field names, or may be manually mapped by the user. Case Notebook will
automatically recognize certain types of load files.
Reports - Batch Save Source Documents, Transcripts, Pleadings and Research
Save Reports with all referenced source Documents, Transcripts, Pleadings and Research
items as separate PDF files. The Report will serve as a hyperlinked table of contents,
providing convenient linking to the saved source items. This new batch save feature will
be available for Issues, Key Facts, All Annotations and other reports.
Outlines - Batch Save Source Documents, Transcripts, Pleadings and Research
Save Outlines with all of the referenced source Documents, Transcripts, Pleadings and
Research items as separate PDF files. The Outline will serve as a hyperlinked table of
contents, providing convenient linking to the evidentiary source items referenced in the
Outline.
Reports Usability Enhancements
Reports now include options to select different report display fonts, to modify or
remove the icon display in the report, and to display transcript dates with titles. Issue
color display has also been improved to display the issue color of the reported item.

Compatibility with Windows Server 2016 and SQL Server 2016
Added compatibility with Microsoft Windows Server 2016 operating system and SQL
Server 2016.

The following improvements correct known issues from earlier versions:
Removing erroneous PDF component licensing message from Batch Save documents
Corrected issue which placed an incorrect message regarding NovaPDF licensing on the
Batch Save as PDF output.
Unassigned Annotations Removed from All Annotations Report when selection box is
de-selected
Corrected issue with All Annotations Report which persisted display of highlighted
passages, which are not assigned to a named Issue, when the “Include Annotations or
Doc-Level Notes with no Issues” is de-selected.
The following are known issues for Case Notebook 4.5:
Inserting MPEG-2 video into Microsoft PowerPoint 2010 or 2013 presentation
A known issue with Microsoft produces “PowerPoint cannot insert a video from the
selected file” error when trying to insert an MPEG-2 video into a PowerPoint 2013 or
2010 presentation. Microsoft offers workarounds in their knowledge base.

Case Notebook 4.0.1 – Release information for July 2016
The Westlaw Case Notebook release includes the following enhancements:
Video Position Information for Designations List Report
The Designations List Report will now contain the specific video position information for
each designation.
Designation Pattern Usability Improvement
The patterns distinguishing designation bars in transcript display and printouts have
been modified for increased visibility in the software and printouts.

The following improvements correct known issues from earlier versions:
Research from Westlaw with very long file names
Case Notebook accepts Research data from Westlaw with very long file names by
truncating file names with more than 256 characters.
The Designation List Report page breaks
The designation list report has been corrected so that there is no incorrect page break
inserted between page and line numbers of a single designation.
Batch saving PDF files with certain characters in the file name
Batch saving PDF files in Case Notebook now creates valid links when the file name
contains special characters recognized by Microsoft Word and WordPerfect.
The following are known issues for Case Notebook 4.0.1:
Inserting MPEG-2 video into Microsoft PowerPoint 2010 or 2013 presentation
A known issue with Microsoft produces “PowerPoint cannot insert a video from the
selected file” error when trying to insert an MPEG-2 video into a PowerPoint 2013 or
2010 presentation. Microsoft offers workarounds in their knowledge base.

Case Notebook 4.0 – Release information for June 2016
The Westlaw Case Notebook release includes the following enhancements:
Customizable Properties
Create custom data properties for Transcripts, Documents, Pleadings, Research and Key
Facts.
Batch Save As PDF
Save numerous file types to PDF at one time using the new File menu, Batch Save as
PDF option. Upon save, a folder is created in the location you specify with a text file that
provides a linked table of contents for the data you saved. Each file is saved into a
subfolder for the data type as an individual PDF.
Tabular/Grid View for all Data Categories
Grid views display a list of all of the files of a certain type in a case and allow you to save
a CSV of all or some files in the list; sort files by title, date, issue, etc; add or remove
columns; move columns; and freeze the first column in the List View. By default, you can
click a category in the Navigation pane to display the List View for that category in the
Display pane.
Designations Printing
New option allows you to select to print only the pages of the transcript that contain
designated text.
Windows 10 Compatibility
Added compatibility with Microsoft Windows 10 Home and Pro operating systems.
Office 2016 Compatibility
Added compatibility with Microsoft Office 2016.
Microsoft SQL Server 2014 and SQL Server 2014 Express Compatibility
Added compatibility with Microsoft SQL Server 2014. Case Notebook and Case
Notebook Administration now install with Microsoft SQL Server 2014 Express.
OCR Multiple Files at Time of Import
Added a selection box to the new file import dialog which initiates Optical Character
Recognition (OCR) processing for all imported image file formats.
Version Lock option
A new option called “Version Lock” is added to the Case Notebook Administration tool.
This option prevents unintended upgrades of a networked Case Notebook case,
particularly by users of the desktop software.

Copy a secure case in Case Notebook Administration
Added option in Case Notebook Administration tool to create a copy of any secure
(Repository) case, with all of the same data, users and permissions in the original case.
Batch upgrade cases in Case Notebook Administration
A new option in the Case Notebook Administration tool permits administrators to
upgrade multiple cases at a time.

The following improvements correct known issues from earlier versions:
Designation Printing displays bars incorrectly when Designation ends on line 25
Corrected issue where a Designation ending on line 25 of the transcript incorrectly
appears to display the bar ending on line 24.
Case Notebook Administration cannot fetch user list from a long Active Directory list
Corrected issue causing import of groups and users from Active Directory to fail when a
very long list of Active Directory groups or users exists.
Send to Video file from Annotations Report
Corrected issue where video clips are not properly named.
Installation of Remote Access Server (RAS) on Windows Server 2012
Corrected issue when installing RAS on Windows Server 2012.
Annotation highlights are misplaced in print preview and printout
Corrected issue where the highlighted areas of annotations are incorrectly placed on
certain native format documents (e.g. Microsoft Word), when printing.

The following are known issues for Case Notebook 4.0:
Inserting MPEG-2 video into Microsoft PowerPoint 2010 or 2013 presentation
A known issue with Microsoft produces “PowerPoint cannot insert a video from the
selected file” error when trying to insert an MPEG-2 video into a PowerPoint 2013 or
2010 presentation. Microsoft offers workarounds in their knowledge base.

Case Notebook 3.6.1 – Release information for March 2015
The Westlaw Case Notebook release includes the following enhancements:
Print Designation details on every page for multi-page Designations
New Page Setup option to print the Designation details in the footer of each page on
which the Designation is present.
Option to always Print Designation details in footer
New Page Setup option to print Designation page:line range in the transcript footer
regardless of whether the Designation includes a Note.
Shorter application startup time when computer is not connected to a network
Open Case dialog now opens in seconds even when computer is offline.
Compatibility with Windows Server 2012 and Windows Server 2012 R2
Added compatibility with Microsoft Windows Server 2012 and 2012 R2.
Compatibility with Microsoft SQL Server 2012
Added compatibility with Microsoft SQL Server 2012.
Open a secure case directly from an .lns file
Navigate directly to a secure case and bypass the Open Case dialog (assuming the user
has that repository in their list) by opening the .lns file associated with that case.

The following improvements correct known issues from earlier versions:
Reports saved to CSV file do not contain column headings
Corrected issue where saving a Report to a CSV file resulted in loss of the column
headers in the CSV file.
Using Send feature from certain text documents does not send complete text to Word
or Reports
Corrected issue where using the Send feature from certain text documents resulted in
the beginning or ending portions of selected or copied text to be dropped.
Word Index will not update if multiple users simultaneously edit same document
properties
Corrected issue with secure cases where Word Index corruption was possible when
multiple users simultaneously made edits to the properties of the same document.
Missing 'Send to ...' context menus in Outlook 2013
Corrected issue where the right-click ‘Send to Case Notebook as Document’ and ‘Send
to Case Notebook as Pleading’ menu options were not present for users of Outlook
2013.
Print Preview for transcript Word Index printing always displays column headings
Corrected issue where generating a Print Preview for transcript Word Index always
resulted in the display of column headers in the margin.
Selection of Case Notebook transcript text within Drafting Assistant causes Microsoft
Word to become unresponsive
Corrected issue where selecting text from a Case Notebook transcript within Drafting
Assistant caused Microsoft Word to become unresponsive.
Case Notebook hangs when editing a Designation Type with same name
Corrected issue causing Case Notebook to become unresponsive when editing a
Designation Type that shares an exact title with another Type in the case.
Outlines cannot print to Adobe PDF printers
Corrected issue where Outlines could not be printed to Adobe PDF printers.
Incorrect Send menu options in Hosted Case Notebook
Corrected issue in Hosted Case Notebook where the Send menu included incorrect
options and did not include the Video option.
Incorrect Designation page numbers display in the transcript footer when printing
transcripts that do not begin on p. 1
Corrected issue with printing Designation details in the transcript footer for any
transcripts not beginning with p. 1.

Unable to scroll through certain transcripts using the arrow keys or the trackball on
the mouse
Corrected issue where the arrow keys and trackball would not properly scroll through
the transcript text.
Video clips created from files accessed through VideoSite are empty
Corrected issue where video clips created from files accessed through VideoSite were
empty.
The following are known issues for Case Notebook 3.6:
Case Notebook Administration fails to export Case List to CSV file
In Case Notebook Administration, the Export Case List option fails to create the Case List
CSV file.

Case Notebook 3.6 – Release information for October 2014
The Westlaw Case Notebook release includes the following enhancements:
Transcript Designations Feature
New feature allows users to mark and add notes to important transcript text for use as
trial designations. Designated text is indicated both in Case Notebook and in printed
transcripts by colored and textured vertical bars in the margin. The transcript with
designations and notes can be submitted to the court before trial. Batch import/export
designations as CSV to/from opposing counsel and review summaries of all designations
via the Designations List Report.
Firm Central Integration
The Case Notebook delivery option in Firm Central enables the export of Firm Central
user documents directly to Case Notebook. Users can deliver document originals or
web versions that include Firm Central notes and highlighting. Firm Central markup will
import to Case Notebook as Annotations and Notes.
Display page counts for all Documents, Pleadings, Research
Total page count and current page number information is displayed when viewing the
contents of the Documents, Pleadings, and Research folders.
Go to First/Last Page options for all Documents, Pleadings, Research
Scroll one page at a time or jump to the first or last page for all content in the
Documents, Pleadings, and Research folders.
Office 2013 Support
Case Notebook 3.6 supports Microsoft Office 2013.
Change to OCR column display in Documents table
OCR column in the Documents table displays OCR, N/A, or blank to make it easier to
identify the OCR status of a document.
CSV added to dropdown list of File Types when importing a Load File
Added .csv to the list of File Types when importing a load file to Documents, Pleadings,
or Research.
Updated Case Notebook Help System
The contents of the Case Notebook help system were reorganized and expanded to
provide quick access to all the features and functions of Case Notebook. All content is
indexed, searchable, and cross-referenced with other topics.

The following improvements correct known issues from earlier versions:
Video not scrolling text when transcript does not begin on page 1
Corrected an issue where video playback did not scroll through the transcript text for
transcripts that do not begin with page 1.
Word crashes after using the html send function in Drafting Assistant
Corrected an issue causing Word to crash when sending text from a Case Notebook
document within Drafting Assistant
Application becomes non-responsive when tabbing through Transcript Summaries
Corrected an issue where tabbing through certain Transcript Summary fields caused the
application to become non-responsive
Data loss when importing 3.5 local case using 3.0 Admin
Corrected an issue that caused potential data loss when importing a 3.5.x local case
using a 3.0 version of Case Notebook Administration.
4-term searches in quotes crashing Case Notebook
Corrected an issue where running 4-term searches in quotation marks caused the
application to become non-responsive.
Unable to import a LEF file made with LiveNote Central online LEF Maker
Corrected an issue where LEF files made with LiveNote Central online LEF Maker could
not be imported into Case Notebook.
The following are known issues for Case Notebook 3.6:
Video performance through Citrix
Transcripts with synchronized video experience a variety of playback problems on Citrix.
Saved video clips from transcripts with synchronized video experience a variety of
playback problems on Citrix.
Formatting issues resulting from full-document OCR conversions for certain
documents types
Full-document OCR conversions through Drafting Assistant for documents with certain
formatting (eg. tables, multiple columns, line numbering, text boxes) can result in
improper text conversions in the resulting document.
Cannot send MPEG-2 video clips to PowerPoint
"PowerPoint cannot insert a video from the selected file" error when inserting an
MPEG-2 video into a PowerPoint 2013 or 2010 presentation.
Cannot import transcript designations from PCF files
Designations do not import when importing PCF files.

Sending video to TrialDirector does not work on Windows 8
Case Notebook supports versions of Trial Director which are not compatible with
Windows 8. Sending annotations to TrialDirector will not work on Windows 8.
Sending video to PowerPoint not functional without “Office Shared Features” installed
from Microsoft Office
Transcript text with synchronized video cannot be sent to PowerPoint unless the “Office
Shared Features” option in Microsoft Office is installed.
Overlapping Designation Note text in transcript footer in Print Preview
Designation Note text can sometimes overlap the page:line range in the transcript
footer when viewing in Print Preview (no impact to print output).

Case Notebook 3.5.1 – Release information for September 2013
The following improvements correct known issues from earlier versions:
Saving Transcript Annotations Files
Corrected issue which caused Transcript Annotations Files to list incorrect page numbers
and Issue names.
Importing Transcript Annotations Files
Corrected issue which caused Case Notebook to create Annotations on incorrect pages
when importing from a custom-created CSV file.
Blank End Position Field in Transcript Annotations Files
Changed behavior of Transcript Annotations Files so that a blank ‘End Position’ field in a
CSV file will mark the transcript through the end of the selected line.
RAS Connection Changes
Prevent certain RAS connection errors by not allowing Case Notebook to connect to any
older version of RAS.
Importing Lextranet Load Files
Corrected issue which caused errors when importing Lextranet load files.
Opening Annotations Folder in Navigation Pane
Corrected issue which caused slowness in opening Annotations folder in Navigation
Pane for certain large image files.
Send to Realtime Chat
Corrected issue which caused Send to Realtime Chat to fail to send the text to chat.
Importing Older RealLegal Binder Projects
Corrected issue which caused errors with transcript dates when importing older
RealLegal Binder projects that have a date associated with the time.
Issues Report
Corrected issue which caused Issues Reports to omit data when choosing a subset of all
available documents.
Word Index Display when Importing through RAS
Corrected issue which caused the display of an empty Word Index when importing long
text files and OCR’ed image files through a RAS connection.

Westlaw Case Notebook 3.5 – Release information for May 2013
The Westlaw Case Notebook release includes the following enhancements:
OCR Text Delivery
Image converted to text using Case Notebook’s Optical Character Recognition (OCR)
technology can be delivered directly to the word processor. Converted OCR text from
Case Notebook documents can also be delivered to work product via the Case Notebook
integration with Westlaw Drafting Assistant.
Portal
The Case Notebook Portal component facilitates building of custom web parts into
matter-centric intranet pages, allowing intranet users to view lists of Case Notebook
matter-centric information and open the full text of the Case Notebook materials in the
desktop client.
Batch Transcript Annotation Import (Designations)
Import CSV files containing annotations or designations from opposing counsel.
Imported data becomes Transcript Annotations in Case Notebook. Transcript
annotations can also be exported to a CSV file from Case Notebook to provide to
opposing counsel or other Case Notebook users.
Save Documents List as CSV
Save Documents grid to a CSV file for creating exhibit lists or advanced sorting and
filtering.
Search Highlighting
Customize search highlighting color and choose default color.
Updated SQL Express
Case Notebook now installs SQL Server Express 2008.
OCR Options
New OCR processing options to improve handling of low resolution images, rotated
pages.
Default Settings for Issues Reports
All issues and options are deselected by default when first opening the Issues Report
dialog.
The following improvements correct known issues from earlier versions:
Autotags Report
Changed the way hits are displayed when Autotag consists of a multiple words in
quotes.
Updating Linked Transcripts With Publisher Bundles

Corrected issue which caused links to exhibits in a transcript to break when updating the
transcript with a Publisher bundle.
Updating Linked Transcripts with LEF Files
Corrected issue which caused duplicate exhibit links to be created when updating a
transcript with a LEF file.
Character Recognition in Repository Cases
Corrected issue which caused a system failure when a user attempts to open a
document in a repository case while another user uses the Character Recognition tool in
the same case.
Quick Mark Display in Printed Transcripts
Corrected issue which prevented Quick Marks from displaying in printed transcript even
if Include Quick Marks option is selected.
The following are known issues for Case Notebook 3.5:
Small Business Server Compatibility
2003 Small Business server 32-bit and 2008 R2 Small Business server 64-bit do not
support the installation of SQL Server Express 2008.

Westlaw Case Notebook 3.0.1 – Release information for August 2012
The Westlaw Case Notebook release includes the following enhancements:
French Canadian Operating System Support
Westlaw Case Notebook supports installation on French Canadian language versions of
Windows 7, Vista and XP operating systems.
The following improvements correct known issues from earlier versions:
Transcript Dates Changed During Legacy LiveNote Upgrade
Corrected an issue which caused incorrect Transcript dates to transfer to Case Notebook
3.0, when upgrading from legacy versions of LiveNote software.
LiveNote Realtime Refresh
Corrected text transcription issues with the LiveNote Realtime refresh feature, which
was implemented in Case Notebook version 3.0.

Westlaw Case Notebook 3.0 – Release information for April 2012
The Westlaw Case Notebook release includes the following enhancements:
Westlaw CaseLogistix Integration
Send to Westlaw Case Notebook from Westlaw CaseLogistix delivers additional work
product and metadata properties, including Tags, Intellifolders, Notes, Redacted text
locations, Date Sent, Date Received, Date Created, Date Accessed, Date Modified, Date
Printed and Custodian.
WestlawNext Integration
Send to Westlaw Case Notebook from WestlawNext delivers additional work product
added in WestlawNext as text highlights, notes pertaining to highlighted text and notes
pertaining to the entire document. Exporting this information to Case Notebook allows
access to the work product added to WestlawNext research with a click of a button.
Data Groups Sub-categories
Case Notebook supports sub-categories for Data Groups (folders), allowing support of
imported Intellifolders from Westlaw CaseLogistix and offers new options familiar to
Microsoft Outlook users.
Data Properties Overview
View all Properties of Transcripts, Documents, Pleadings and Research on an Overview
tab, with links to view and edit existing Properties on their respective tabs.
Document Properties List
View Document Properties in a tabular list, allowing flexible sorting options and multiselection and deletion options.
Realtime Rapid Refresh
The court reporter can make updates to the text of the Transcript during breaks in a
Realtime deposition and the attorney will see the updates in Realtime and in the rough
draft at the end of the Realtime session.
LiveNote Local Stream
The court reporter can broadcast LiveNote Realtime Stream on a local area network at
deposition location, without need for a serial connection cable or an internet
connection.
Batch Print Options
New batch print option allows printing of the linked Exhibits in the same print request
with the Transcript.
Sorting for Reports
New sorting options for the following reports: Issues, All Annotations, Characters,
Transcript Summaries & Quick Marks.
Reports Display Options
New display options for Reports include the option to display data Properties in the
Report result.

Header and Footer on Printouts
Display descriptive information about a Transcript (e.g. deponent name, deposition
date) in the header and footer of each page for easy identification of printouts of
selected Transcript pages.
Issues Sub-folder in Navigation Pane
Annotations can be viewed in folder categories in the left Navigation Pane, using the
new option found in View > Display Options.
Case Summary
A new option found in File > Case Properties displays a summary of the case contents,
including the number of Transcripts, Documents, Pleadings and Research in the case.
Administration Search Index Rebuild
The administrator can rebuild the search index for a secure Case Notebook case as a
background process during the repository upgrade.
Supported Platforms
In Terminal Server mode, Case Notebook will run on Windows Server 2008 R2 and
Windows Server 2008 R2 SP1 for Citrix XenApp version 6.
Branding Updates
New product icons and branding standardize display of the product name to Westlaw
Case Notebook.
OCR Engine Upgrade
Upgrade the built-in Optical Character Recognition (OCR) technology to the latest
version.
The following improvements correct known issues from earlier versions:
Transfer to PowerPoint
Improved display issues when sending certain annotation to PowerPoint.
Full Text Search
Improved slow Full Text Search performance with certain types of quotation search
operator and near operator searches.
Rebuild Character Smart Tags
Corrected error when trying to use the Tools > Advanced > Rebuild Character Smart
Tags…using a Citrix client.
Annotation Display on Printouts
Corrected error printing Documents with Annotations displayed in the footer to
correctly display the annotation information on the same page as the annotated
passage of text.
Realtime Transcript Format after Disconnection
Corrected behavior which caused a Transcript formatted for a number other than 25
lines per page to be re-formatted to 25 lines per page, after disconnection from
Realtime session.

Annotations of Single Alpha-Numeric Characters
Corrected issue which did not allow users to open or access the right-click menu for
annotations of single alpha-numeric characters.
Printing Individual Transcript Pages with Annotations
Corrected issue which caused the incorrect pages of Transcripts to print when
annotations are added to the footer and individual pages are selected for printing.
Full Text Search using Accent Marks
Corrected issue which did not return Full Text Search results when searching native text
containing accented words, using search characters which also contain the same accent
marks.
Upgrading Repository User Transfer
When performing a Repository upgrade from legacy LiveNote 10 to Case Notebook 3.0,
group users from the LiveNote 10 case are no longer incorrectly added as individual
users to the Case Notebook case. Note, this issue will still occur if attempting to
upgrade from legacy LiveNote 10 to Case Notebook 1.6 or 2.6.
Auto Tag Character Limitation
Corrected issue which caused an incorrect limitation on the number of alpha-numeric
characters which can be marked as an Auto Tag.
Sorting Data in Left Navigation Pane
Corrected issue which caused a system failure when sorting a Document, Pleading or
Research item, when only one item exists in the case.
The following are known issues for Case Notebook 3.0:
Microsoft Office 2010 64-Bit Compatibility
The Case Notebook integration with Drafting Assistant will not be available in the
Microsoft Word interface for the Office 2010 64-bit version. The workaround for
Drafting Assistant users, with Case Notebook, will be use of the full desktop Case
Notebook client.

West Case Notebook 2.6 – Release information for September 2011
The West Case Notebook release includes the following enhancements:
Sorting Options
Sort Full Text Searches, Full Text Search Reports & Auto Tag Reports by Number of Hits,
Date, Reverse Date and Title.
Legacy LiveNote Repository Upgrade Improvements
Legacy LiveNote Repository upgrade process is streamlined with enhancements to the
Administration software.
Play Video and Edit Video Clip Updates
Right-click anywhere in a video-synchronized transcript and select Play Video. Edit the
start and end point of annotated video clips.
Attachments
Attachment locations will display an icon in the left margin of Transcripts.
Add to Data Groups
Categorize data sent from Outlook & CaseLogistix into Data Groups.
Annotation Changes Offline
Change and delete annotations (with proper user rights) while replicated offline.
Copy with Page & Line Citation
Copy with Page & Line for Transcript text also delivers a citation to the passage.
Online Lessons
Access free online training via the “Online Lessons” option in the Help menu.
The following improvements correct known issues from earlier versions:
CaseMap Links
Convert links sent to CaseMap from legacy LiveNote versions 8.3, 9 & 10 to ensure
working links back to West LiveNote/Case Notebook.
Reports for Drafting Assistant
Corrected linking issues in the Key Facts Report created for Drafting Assistant.
Full Text Search Wildcard
Corrected search issues related to the character wildcard (*).
Print Dialog Window
Corrected the Print dialog window display slowness for Reports with video.
Data Groups Display Performance
Data Groups performance improved when editing certain Groups data.
Realtime Word Indexing
Corrected errors with Realtime word index if connecting an existing transcript.
OCR and PDF Documents

Updated process for recognizing borders between image and text in PDF files.
Outlook 2010 Send to Case Notebook Integration
Updated Send to Case Notebook from Outlook 2010 to correct set up error occurring in
limited circumstances.

West Case Notebook 2.5 – Release information for March 2011
The West Case Notebook release includes the following enhancements:
Enhanced Performance
Improved system performance and increased capacity.
Support for Office 2010
West Case Notebook 2.5 supports Microsoft Office 2010.
Print from Display Pane
Print and Print Preview options available on the display pane toolbar.
Send as Research
Send data to the West Case Notebook “Research” category from Windows Explorer.
Load Files Support for Groups
Add batches of information to Data Groups while importing Load Files or multiple files.
Export Key Facts to CSV
Improved display for Key Facts saved as .CSV.
Spell Check all of a Transcript’s Summaries
Spell check all Transcript Summary items.
iManage DMS DeskSite and FileSite Integration
West Case Notebook iCommand allows users to send data to Case Notebook from
iManage DeskSite and FileSite.
The following improvements correct known issues from earlier versions:
CaseMap Links
Send to CaseMap creates a working link back to West Case Notebook 2.5.
Full Text Search Results
The Full Text Search Results list does not collapse after making an annotation.
Full Text Search Data Selections
Data selections for Full Text Search carry over to Full Text Search Report.
Remote Access Server (RAS)
Corrected issues which occurred under specific circumstances when multiple users
accessed Remote Access Server (RAS).
OCR File Replication
Corrected issues related to replication of OCR files.
LEF Files
Corrected handling of LEF files with four character file extensions.

West Case Notebook 2.1 – Release information for October 2010
Below is a list of some minor new features and bug fixes in West Case Notebook v2.1.
The primary purpose of v2.1 is to integrate with Westlaw Drafting Assistant – allowing
you to bring West Case Notebook case files into a word processor (Word and
WordPerfect).
Updated Gil Bower Demo Case Materials
Enhancements to the demo case make it easier to work with Transcript Summaries and
Key Facts.


All Transcript Summaries removed for the Transcript of the “Cynthia Roth”
deposition, leaving space to create new Transcript Summary items.



Removed the last Transcript Summary entry for each deposition Transcript, leaving
space to create new Transcript Summary items.



Deposition Transcript annotations added as sources for some Key Facts.

The following improvements correct known issues from earlier versions:
Annotation Highlights and Notes in Reports
Corrected display issues with annotation highlights and notes occurring in some reports.
Changed User Name when Case Offline
Corrected issues related to logging into an offline database if the user name is changed
in West LiveNote Administration while the user is offline.
Selective Replication of Data Groups and Outlines
Corrected issues related to selective replication of data groups and outlines.
PowerPoint Integration
Corrected issues related to sending information to PowerPoint from some Reports and
Key Facts.
Character Recognition
Improvements to the Character recognition processing and accuracy.
Annotation Note, Full Text Search, Right-click Options
Full right-click menu options are displayed when right-clicking the Annotation Note hit
within a full text search result list.
Annotation Full Text Search, Annotation Dialog
The annotation property dialog opens, allowing editing of the annotation, when clicking
an Annotation Note hit within a full text search result list.
Transcript Summary
No longer able to change the first page/line of an existing Transcript Summary item to
be in a range of another existing transcript summary item.
OCR and PDF Documents
Updated process to better recognize existing OCR from Adobe PDF documents.

West Case Notebook 2.0 – Release information for August 2010
The West Case Notebook release includes the following enhancements:
Folder options
 Folder display in the left-hand navigation pane.
 Use Data Groups to organize display.
 Organize display in navigation pane by data properties.
Characters
 Import Characters in batch from Microsoft Outlook Contacts.
 Identify Person and Company names in West Case Notebook data during indexing.
 Generate Character reports from the automatically tagged names.
Selective Replication
You can select specific documents for use in an off-line mode.
Remote Access Server (RAS)
 West Case Notebook 2.1 desktop application can remotely access centralized West
Case Notebook Repository data via HTTP or HTTPS.
 RAS uses a set if components running on IIS T that act as a web service to
communicate with Repository.
Outlines
 Insert links to exhibits in the Outline.
 One print window for the Outline, annotated work-product copies of the exhibits
and sets of original exhibits for distribution.
 A basic word processor to create outlines of witness examination questions and
topics.
Transcript Summary Tool
 Built-in Transcript Summary tool allows you to summarize depositions without
switching between applications.
 Create and save a useful pre-formatted Transcript Summary report.
Print Word Index
Transcript printing and page setup options now allow you to append and print the word
index for full-sized and condensed Transcripts. The word index prints at the end of the
printed Transcript.
Indexing and OCR in Background
The search index is built in the background, allowing you to keep working while the
build/rebuild takes place.
Sub-Issues
Create numbered subcategories for Issue highlighting.

Send to Word
File name and page references are now included for Documents, Pleadings and nonWestlaw Research. This feature makes it easier to cite to Exhibits and Pleadings in
drafting projects.
OCR Processing Error Handling
If you import multiple image documents and an OCR processing error occurs on one or
more of those images, West Case Notebook silently skip the file with the OCR error until
the entire process has completed. After the OCR process completes, a dialog lists all of
the skipped documents that could not be OCR’d. You have the option to copy the list to
a clipboard for further review of the underlying data. The items with OCR errors do not
have a check box in the OCR status list.
Single Character Indexing
West Case Notebook can index single alpha-numeric characters.
Create Characters from CSV
West Case Notebook can import CSV files created from exporting contacts in Microsoft
Outlook, as well as custom CSV files created with the same formatting as the Outlook
export format.
Data Selection List Sorting
The data tab selection lists for Reports, Search and so forth is now displayed in columns
that you can sort by Title and Date.
Adding to Data Groups
Add items to a Data Group using the context menus available for data listed in left
navigation pane.
Linked Exhibits Display Order
Exhibits are linked in the order of their appearance in the transcript, in the left
navigation pane.
OCR Upgrade
The ABBYY OCR engine has been upgraded to latest SDK. The latest versions increase
processing speed and accuracy.
Key Facts Report
Key Facts Report allows you to create a summary report of some or all of the Key Facts
of the case.
Send Key Facts
The option to Send Key Facts to Word and WordPerfect allows you to select one or
more Key Facts and send them directly to their drafting project.
Case Reports
Case Reports allow the selection of individual Key Facts.

OCR Information Imported
When PDF imports contain embedded OCR data that West Case Notebook can
recognize, the import procedure does not re-OCR the data; in other words, the import is
faster.
Update KeyCite Flags
 Update KeyCite Flags menu option is now under the Tools dropdown.
 The login for the Update KeyCite Flags process allows you to enter OnePass
information.
Foreign Character support
Support for Latin-based foreign language characters in serial Realtime and data
properties.
Support for Additional Systems
West LiveNote Repository will support SQL Server 2005 or SQL Server 2008 if a named
instance (for example, WESTLIVENOTE) exists on the server.
The following improvements correct known issues from earlier versions:
Support for Additional File Formats
West Case Notebook supports JPEG2000 or JBIG2 images embedded in PDFs.
Pausing Realtime
Clicking a paused Transcript does not cause the Transcript to continue scrolling; the
Transcript remains paused.
Installation
The West Case Notebook installer detects the current operating system and stops the
installation when the operating system is not supported.
LEF Files from Publisher 5.x
Corrected errors with native file formatted Documents importing from a LEF file created
with Publisher 5.X.
LEF Files with Linked TIFF Exhibits
Corrected errors with LEF files retaining *.tiff file format linked Exhibits.
Transcripts with More Than 85 Characters in a Line
Corrected import processing of Transcripts with more than 85 characters in a single line.
Westlaw Research Data and Word Index
Corrected Word Index processing for certain Westlaw research data which previously
caused the system to hang up.

